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Perform Advanced Clone Function 
There are 3 major changes of Clone function in PAD V6.  
 It allows setting Clone pieces on Plan View. 
 It allows creating more Clone generations.  
 The Clone piece can be modified individually, and once the Master piece has 
been modified, changes will be reflected to the Clone piece again. 

To obtain a clone piece in Plan View 

You may make a Set Piece and check the Plan Clone option at the middle of the 
dialog box. The modifications make to the Plan (Master) are automatically 
reproduced in all of the cloned pieces (Clone). 
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You have 3 options to choose how to modify Clone piece, 
Unlocked: It allows to make modifications on its. 
 
Editable from Master Only: It blocks the Clone piece from any modifications made 
on its contour, allowing modifications only from the Master piece on the contour. 
Internal references can still be added, modified or removed from the Clone piece. 
 
Locked: It does not allow making any modification. The piece is available as a 
reference (read only) until unlocked. 
 

 

To create more Clone generations in Plan View/ Piece View 

You may create the first Clone piece from a Master. A small symbol will appear on 
the side of Master Piece . 
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Then you may create the first Clone pieces from the Master piece to identify as Self 
fabric. A small symbol will appear on the side of Clone pieces . 
 

 
 

 

And then you need to create another Clone pieces from the first Clone piece to 
identify as Lining. A small symbol will appear on the side of Clone pieces . 
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To modify Clone piece individually and (or) modify Clone piece by Master piece  
 
If the option Unlocked is checked in the Set Piece’s dialog box, you can modify the 
clone pieces if necessary. For example; you make changing to the second Clone 
pieces as the following picture shown, 

 

 

 

If you need to change the length and the width on the Master piece; it will be 
affected to the Clone piece again as the following picture. 
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Besides you can do the same modification in Pieces View, it supports the Clone 
pieces with Seam Allowance and Intelligent Mirror. 
 
For working on Grading View, all of Clone grading must be affected by the Master 
pieces. Ex: If Clone pieces are graded, then you makes grading to the Master 
Piece, all of the Grading modification will be affected to all Clone pieces again. 
 
Note: If the pieces are generated from Clone piece. When adding Seam Allowance, 
it should apply to the Master Clone piece. Then seam value will apply the same to 
the corresponding Clone pieces. 
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Enhance Curve drawing 

To enhance Curve line drawing and Curve line modification. 
 

To Draw a Curve Line by Freehand 

 
How to do so: 

To select “Curve” and click on the define positions.  It allows drawing a curve 

line by three clicks only. 
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To Move a Group of Control / Regular Points by Freehand 

To do so: 
1 To activate the segments you would like to modify curve on. 
2 To select the Curve tool 
3 Click one of the Control / Regular point on the selection 
4 Hold down the left mouse button and drag to the desired position, the result will  
  preview as stitch line on screen.  

 
 

To Move a Group of Control / Regular Points with Numeric Values 

To do so: 
1 To activate the segments you would like to modify curve on. 
2 To select the Curve tool 
3 Click one of the Control / Regular point on the selection 
4 Hold down the Alt key (Windows), the Option key (Macintosh) or Alt + Windows  
  Keys (Linux). 
5 Move the cursor, click on the desired location where you want the shape to be. 
  A dialog box appears: 
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6 Enter the X and Y values (in user predetermined measurement units) to move the  
  selected point in precise horizontal (X) or vertical (Y) directions. A positive value  
  moves the selection to the right/top. A negative value moves the selection to the  
  left/down. 
7 Click OK button to validate. 
 

   



 

© 1988-2013 PAD System™ International Limited. All rights reserved. 
14

MTM Optimization 
The purpose of MTM Optimization is to simplify some procedures when you are 
setting Frames to a piece.  
Frames will create automatically and simplify the definition of Measurements. 
 
To pre-set the most used Center Segment List, Frame Name List, Frame Segment List 
and Select Spec to Frames window sub-menu. 

 

Center Segment List…: It allows creating the most used Center Segment into a list.  
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Frame Name List…: It allows creating the most used Frame Name into a list.  

 
 
 
Frame Segment List…: It allows creating the most used Frame Segment into a list. 
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Select Spec…: There are four categories (Body, Sleeve, Collar and Bottom) in the 
dialog box of Select Spec. And each category will pre-set the most used items to 
each category and let you to choose. 

 
And each category will pre-set the most used items to each category. 
 
The first drop-down menu let you to select all existing sets. You may select the set of 
the new spec belongs to. If there are no existing sets, Set 1 will be created by 
default. 
 

New: Add and name a new item at the end of the list. 
 
Delete: Remove the selected item from the list. 
 
All items in the Center Segment List, Frame Name List, Frame Segment List and 
Select Spec are saved in the Pattern Preferences file. 



 

© 1988-2013 PAD System™ International Limited. All rights reserved. 
17

Contextual Menu in Frame View 
There are four new items (Item Info, Specify Calculation (Measure), Specify 
Calculation (Level) and Reverse Segment Orientation) on mouse right click 
sub-menu.  

 
Item Info To select one of the Frames and right click on mouse to choose Item Info. 
A dialog box appears; you can enter the frame name to the text box or click on the 
Name drop down menu to select the frame name pre-set from Frame Name List. 
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Specify Calculation (Measure) / Specify Calculation (Level) 
To select one of the Frames and right click on mouse to choose Specify Calculation 
(Measure) / Specify Calculation (Level). A dialog box appears as follows.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You will get the dialog box if you click on the  icon next to the Measure / Level 
items.  
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Reverse Segment Orientation 
To select one of the Segment and right click on mouse to choose Reverse Segment 
Orientation.  The selected Segment will reverse to opposition direction.  
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Create Center Segment 
 
1 Activate the pattern piece. 
2 Select the Create Frame tool in the Toolbox. 
3 Click the first point on the contour of the shape where you want to place your  
  Center Frame. 
4 Click the second point on the contour of the shape where you want to place     
  your Center Frame. 
5 Enter the Center Frame name to the text box or click on the Name drop down  
  menu to select the Center Frame name pre-set from Center Segment List. 
 

 
 
6 Choose the item on the drop down menu for Set and Characteristic. Press OK  
  button to validate.  
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Create Frames Automatically 
Frames are added to the piece automatically. And all of Frames details display on 
the Frames window. The first Frame (First click on the Center Segment) created on a 
Center Frame is the Level Zero. Level Zero is the starting position for measurements 
of the pattern pieces according to the length. It should be placed at the same 
position on all related pattern pieces. The Level Zero frame line appears blue and 
thicker than other frames on the piece. Once you have defined Level Zero, all 
other Frame Levels for that pattern piece are calculated from that Level Zero frame. 

 
 
Frames are added and named to be a Digital and display on the Frames window. 
You may rename the Frames by choosing the Item Info on mouse right click or 
double click the item on the Frames window. 
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Create Internal Frame 
Internal Frames could be added to the piece. And all of the Internal Frames details 
display on the Frames window and the feature is the same as Contour Frames.  
All Internal Frames level are measured starting from Level Zero, which is the first 
Frame created. 
 
To create Internal Frames: 
1 Activate the pattern shape(s). 
2 Select the Create Frame tool. 
3 Click an internal point, located in the pattern piece where you want the Internal   
  Frame to be set. 
4 Click the Center segment for the fixed position (Center Frame). 
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The Frame dialog box opens: 

 
 
5 Enter the name of the Frame and press OK button to validate. 
 
Internal Frame added on Opened piece or Half piece: 
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Create Formula between Measurements Intelligently 
 
To do so:  
1 Activate the Frame needs to be added formula. 
2 Right click on mouse to choose Specify Calculation (Measure) / Specify     
  Calculation (Level).  
 
  The Specify Calculation dialog box appears: 
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3 Select one of the frames as a Master frame that relates to the corresponding  
  frame “Across BK”.  

 
  Or, 
  Click one of the frames from the Frames window as a Master frame that relates to  
  the corresponding frame “Across BK”.  
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4 The formula is automatically created and displayed on the formula box. 
  Example: Measure(Back:Shoulder BK) - 1.127  
  That means Across BK measures to Shoulder BK.  And the value (1.127) at the  
  end, that is the difference between Shoulder BK (Master Frame) and Across BK. 
5 Press OK button to validate the formula. 
6 Put cursor to the corresponding frame “Across BK”. A tool tip appears as follows. 
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Create Specs by Default Items from Select Spec 
 
To do so:  
1 To choose Select Spec… from Frames window sub-menu 
2 A dialog box appears; you can use mouse drag to select several items.  

 
 
 Or hold down Ctrl +Alt keys to choose your desired items from the list. 
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3 Press OK button to validate. Your desired Specifications are in the Frame window  
  under the Specs category.  

   
 
 
Delete Specs without Adding Formula from Frames Window 
It allows deleting the Specs without formula from Specs category by multiple 
selections. It does not delete Specifications one by one. 
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Rearrange the order of Frame items in Frame window 
It allows to re-arrange item order at five categories; Centers, Links, Segments, Spec 
and Measurement Charts in Frame window.  
To do so: 
1 Select the item need to be moved 
2 Click on it and hold down mouse button    
3 Move to the desired position and release mouse button  

                   

Or it allows moving the item for a pattern piece in Centers category. 
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Measurement Charts 
Measurement Charts is an individual category in Frame View window, user can 
define various items and set value on it accordingly. Once the value of item in 
Measurement Charts is modified or changed, all corresponding items (Frames, 
Segments or Links) will be automatically updated. 
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To create a New Measurement Charts: 
 
1 Select New Measurement Charts…from the drop-down menu in the Frames  
  window. 
 

   
 
2 In the Measurement Charts dialog box, enter a name and select the set for the  
  New Measurement Charts belongs to. The Set drop-down menu lists all existing  
  sets. If there are no existing sets, Set 1 will be created by default. 
 

   

 

3 Click the OK button to execute the function. 
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Created items are listed in the Frames window under the Measurement Charts 
category. 
 
Using the same method as with Formulas, combine necessary Measurement Charts 
to obtain Frames, Links and Segments value you need. 

 

Once the values in Measurement Charts are modified, all corresponding Frames, 
Links and Segment are updated automatically. 
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Exporting Measurement Charts 
Once Measurement Charts are created, their measurements can be exported to 
an external database. 
 
To export the Measurement Charts information: 
1 Select the Export... item in the File menu. 
  The Export dialog box opens: 

   
2 From the File format pop-up menu, select the Measurement Charts file format. 
3 Click the OK button to execute the function. 
4 If more than one set exists in the Export window, a dialog box appears, enabling  
  you to select the set(s) to export. You can export more than one set at once. 

   
5 A Save dialog box opens. Enter the File Name and click the Save button.  

Once exported, the Exported file can be opened by any standard software that 
supports text files. 
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Importing Measurement Charts  
If Measurement Charts information is modified in an external database or any other 
software that supports text files, it can be imported back in the pattern file. 
 
To import Measurement Charts information: 
1 Select the Import… item in the File menu. The Import dialog box opens:  

   

2 Select the Measurement Charts item from the File Format drop-down menu. 
3 Click the OK button to execute the function. 
4 If more than one set exists in pattern file, select the corresponding set from the list.  

    
5 Select the set to import and click the OK button to execute the function.  
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Keep Frames to the piece if Split Piece & Combine Pieces 
PAD V6.0 will keep the frames, segments to the piece after splitting and combine.  
In previous version, the pattern piece set frames in Frame View, but if you may 
need to split it into 2 pieces, all frames will be removed completely. You have to 
apply all frames to the piece again. 
 
To split a piece into 2 pieces and keep frames on: 
Here is the original piece with setting Frames. 

     

 



 

© 1988-2013 PAD System™ International Limited. All rights reserved. 
36

Once it splits to 2 pieces, it creates a new Center items for the split piece in Frame 
list. It creates a new Center item and adds suffix C to the piece name. 

 

 
If a piece with Frames is being split into 2 pieces, the split segments will create a 
point for the position of Frames. 
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To combine 2 pieces to a piece and keep frame on: 
Here is the example for 2 pieces set with frames. 

 
 
One of the pieces needs to be split, part of piece in Plan View as follows. 

 



 

© 1988-2013 PAD System™ International Limited. All rights reserved. 
38

You will find the frames still keeping to the piece “Front Blouse” and create the new 
segments on Front Blouse and Front Yoke. 

 
 
Combine Front Yoke to Back Blouse in Plan View and go back to Frame View. 
Back Blouse still keeps all frames and segments on. 
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Pattern Assistant 
The Pattern Assistant… option in the Treatment menu assists users to check error 
from the pattern file.  
To do so: 
1 Select the option Pattern Assistant in the Treatment menu. 

   
 

2 A dialog box appears and all of options to be default on it. 
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3 Press Start button and search the error for all of pieces. The floating window for  
  Pattern Assistant displays all of the items of the error pieces. 

   
4 Click one of the items from the floating window. It will indicate the piece on full  
  screen. Here is the error message for Seam Allowance. 
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An error message for grading 

 

An error message for Point overlap, it will indicate the position (coordinates) of the 
overlapped point. 
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An error message for Notch overlap, it will indicate the position (coordinates) of the 
overlapped point. 

 

 

An error message for Line overlap, it will indicate the position (coordinates) of the 
overlapped point. 
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5 Once the error message is being chosen, it will turn it to Grey color. 
 
Check Error on the Selected Piece 
Right click on mouse to choose Pattern Assistant. A dialog box appears and press 
Start button to search the error on the selected piece. 

 

 

Check Error When Closing File 
Go to Option menu, Preference and General tag page. 
The item is checked, it will start Pattern Assistant if you close the existing file. 
You may press “Esc” button from keyboard to Force Quit this function. 
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Seam Allowance Library 
The Seam Allowance Library allows you to create a list including the frequent used 
seam values.  It also allows you to manage a Master Seam List and share it with 
other Pattern Makers. 
 
Show Seam Allowance Library from Options menu that you can use the Seam 
Allowance Library window to add seam allowance on a segment(s) or even 
several pieces at the time more easily in doing so. 
A tick (　) will show if you choose to Show Seam Allowance Library.  

 

A Seam Allowance Library allows you to keep the seam value in a database. 
You can create as many Seam Allowance Libraries as you need. Each library may 
contain up to 999 seam evolutions available on screen through the Seam 
Allowance Library window. The Seam Allowance Library window lists the number 
and name (if any) of each seam evolution. 
 
Next to each element of the Seam Allowance Library, there is an arrow that 
opens a drop- down menu showing the Seams Characteristics of the element. 
It contains the numbers and names of the Seam Evolutions. Only one Seam 
Allowance Library can be open at a time. 
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Seam Allowance Library Drop-Down Menu 

 

Library commands are available in the drop-down menu, to the upper right of the 
Seam Allowance Library window.   
 
The Library drop-down menu offers the following options: 
New...: It creates a new Seam Allowance Library. 
Open...: It opens a Seam Allowance Library that already exists. 
Open & Reaffect...: It replaces the current Seam evolutions to the pattern pieces  
with those from a chosen Library. 
Close: It closes the open Seam Allowance Library. 
 
 
To create a New Seam Allowance Library: 
1 Select the New… item in the sub-menu from the window of the Seam Allowance  
  Library. The Save new library as dialog box opens. 
 
2 Enter the library name in the File name text field. 
 
3 Press the Save button once you have located the proper folder. The library    
  window appears; enter the name for the Seam Allowance Library file (.seam). 
  To return to the previous window, press on the Cancel button. 

   
Note: All seam evolutions adding to Seam Allowance Library. It saves automatic to 
the Seam Allowance Library. 
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Seam Allowance Library Buttons 
 

 
 New : It adds a new seam evolution to the Seam Allowance Library. 

 
  Edit: It allows modifying information about the seam evolution that is selected.  

     Or get the dialog box on the selected item by mouse double clicks. 
 

 Delete: It removes the selected seam evolution.   
 

 Cancel: It removes the link between the selected seam evolution and the  
    segment(s). Once the linking is removed, the selected item turn to black color. 
 

 Apply: It applies the updated Seam Evolution to the segment(s). 
    If there are more than one item in RED color in Seam Library and it need to  
    update the value to the pieces. It can press Apply to update one by one. 
 
    Just select the item in REB color and press Apply to validate.  
    A dialog box appears: 

     
    Click Continue button to confirm or click Cancel to close the dialog. 
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To open an existing Seam Allowance Library (.seam) file and apply Seam 
evolutions to the piece (s): 
 
1 Select the Open… item in the library sub-menu from the window of the Seam  
  Allowance Library. A dialog box opens. 
 
2 Select the library you wish to open and click the Open button.  
  The Seam Allowance Library appears: 

   
 
3 Select the segment (s) that you want to add seam allowance on. 
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4 Click on the seam evolution in the Seam Allowance Library window. 

   
 
  The selected segments add the seam value by the selected item. 
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To replace all seam evolutions from a chosen Library: 
 
1 Select Open and Reaffect... in the library sub-menu from the window of the  
  Seam Allowance Library. 
 
2 An Open dialog box appears. Select the updated library that will replace the  
  current seam evolutions to the piece(s).  
  A dialog box appears: 
 

   
 
Click Continue button to confirm or click Cancel to close the dialog. 
 
The seam item of the library is applied according to the numbering process and  
the seam value on the open pattern. 
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Pattern Template 

It allows saving the most used Pattern Pieces into a list.  
To do so: 
1 Open the file with some pieces need to save to Pattern Template 
2 Go to Option menu and select Show Pattern Template List. 

  
3 The Pattern Template displays on the floating window. And press “New” from    
  the sub-menu. 
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4 A dialog box appears and please input the name for Pattern Template List. 

   
 
5 The item of the Pattern Template List displays on the floating window. 

   

 
6 To activate the item (Pattern Template List) as the above screen shot. 
  And activate the piece, click right button on mouse and choose the item  
  Create Template. 
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7 Then it saves this piece to the Pattern Template List as the following screen shot. 

   
8 If you would like to save another list for keeping body shape. You can press  
  “New” to create a new Pattern Template List and name to “Body. 
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9 The Pattern Template will save its automatically to the location as follows. 
  C:\Users\May\AppData\Local\PAD System 6\Pattern Design\template 

 

 When you start Pattern Design, it will load the Pattern Template List automatically. 
 
To Save and Open Pattern Template List to another PC 
How to do: 
1 Press “Save” item from the sub-menu. 

    
 
2 A dialog box appears and enter the name for the Pattern Template List and  
   choose the directory to save the file(.temp). 
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3 To open the Pattern Template List to another pc. Please pass this temp file .temp  
  to the station need to open. Start Pattern Design and open or create a new file. 
  Click on the item Open from the sub-menu and choose the file to be opened. 

   

4 A window appears to show all of Pattern Template List of the selected file. 

   
5 You may choose one of them or Select All. 
 
6 To get a piece from the list. Activate the item and drag it to the working area. 
  The selected piece will copy on the current file. 

 
Note: For the pieces setting with Frames, it will keep them to the pieces and save to 
Pattern Template List.  
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Save Changeset 
This feature is for the management of changes to documents. Users are able to 
view the changes on each piece; it does not allow doing any modification on the 
pieces. It keeps the maximum number of Changeset to 3 copies. And it will 
overwrite the last copy if it reaches the maximum number of files.  
This feature is available in Pattern Design only.  
 
To do so: 
1 Open a pattern file and change the measurement on one of the piece. 
  Ex: Add 2 inch at the Sleeve Length 
 
2 Select Save Changeset from File menu; it keeps the previous file in the first copy. 
  Please choose Close from File menu to close this file. 

     

3 Select Open… from File menu; to open the file save with changeset and is able to  
 compare the all of files in Changeset View. 
 
4 Go to Changeset View from View menu to choose the Changeset file to be  
  compared. 
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5 Once the Changeset file is selected; it goes to Changeset View to display the  
  current file and the first Changeset file. And you can choose the pieces to be  
  compared from the Changeset window. All of pieces in the first Changeset file  
  display in Pink color. The pieces will align at the center point.  
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6 The Toolbar allows you to make some actions on pieces in Changeset View. 
  All of the tools are the same function as in Plan / Pieces View. 

     

7 Or you allow using Align Shapes… from Treatment to align pieces. 
 
8 To left the Changeset View, just go to Plan View / Pieces View. The latest file  
  displays on screen. And the Changeset file is hidden until you choose it to  
  view again.  
 
Restore Changeset File to a New File 
You allow copying the whole style to a new .sty file. Put the cursor on the title bar 
and right click on mouse, the contextual Menu appears; please select Copy to a 
New File. A new file appears and all of pieces pastes in it. 
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Set Number of Copy for Changeset Files 
Predetermine the maximum number (Between1to 3) to save for changeset files. 
The item Version Control in Preference and General allows you to set the value. 
The maximum number is between1 to 3. The default number is 3.  
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Optimize the Step on Set Piece 

It allows using double Left Clicks to select the polygon and set it as a piece. 
To do so: 
1 Put the cursor on the piece  
2 Double left clicks on the piece and the cursor will change to “+” sign. 

  

3 Then drag the cursor to the polygons, a guideline in Pink color appears to identify  
  the pieces. The contour lines of the selected pieces activated as follows. 

   
 

4 Then right click on mouse and get the dialog box for Set Piece as usual. 
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New Tool — Segment Sync  
Segment Sync is to copy the selected segments as image and join with another 
segment. Then it allows modifying the shape on the IMAGE and able to put 
modification to the original pieces.    
 
Several Pieces Combine Together 
To do so: 
1 Select the segments need to join together as the follows: 

   
2 Choose Segment Sync tool 
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3 Click on each piece of the joined point, and the first click on the piece that is the  
  fixed piece. 
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4 Then all of selected segments will join as following screen. 

     

5 Move the cursor to the desired position and adjust the shapes what you need. 
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 6 After modified, please right click on mouse to validate. You can see the  
   difference if the pieces added with Template. 
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Close a Dart and Change the Shape 
Closing a Dart temporary and let you to adjust the shape of this piece 
To do so: 
1 Select the segment with a Dart located  

             

 

2 Choose Segment Sync tool and click on the fixed point 
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3 The Dart is closed and may change the shape as follows. 

   

4 After modified, please right click on mouse to validate. You can see the  
  difference if the pieces added with Template. 
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Close a Pleat and Change the Shape  
Closing a Pleat temporary and let you to adjust the shape of this piece. 
To do so: 
1 Select the segment with a Pleat located  

    
2 Choose Segment Sync tool and click on the fixed point 
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3 The Pleat is closed and may change the shape as follows. 

   
 
4 After modified, please right click on mouse to validate. You can see the     
  difference if the pieces added with Template. 
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New Tool — Ruffle  

The Ruffle allows you to create pieces as circle shaped piece. 
To do so: 
1 Select Ruffle tool and click the desired location where you want the shape to be. 
2 The Draw Ruffle dialog box opens. Enter the Length and Height measurements: 
 

    
 
3 Press OK button to validate and get a piece as follows. 
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Or, make a Ruffle with a gap, enter Gap value as follows.     

 

Or, make a Four Flared Skirt as the following screen shot. 

  
Internal Segments: The Ruffle is drawn with internal segments attached to one 
another. They can be deleted so that the piece will not be a closed polygon 
anymore. Otherwise, the Ruffle is drawn with contour segments and remains a 
closed polygon if segments are deleted. 
 
Draw in Pieces View: The drawn Ruffle appears in Pieces View and is missing from 
the Plan View.
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Develop Multiple Pleats 

The Pleat tool allows you to develop multiple pleats in one step. 
 
To develop multiple pleats: 
1 Activate existing points on the shape 
2 Select the Pleat tool 
3 Click the first reference point (A) 
4 Click the second reference point (B) 

   
 

5 Click the fixed part of the pattern piece 
    The Pleat Characteristics dialog box opens: 

   



 

© 1988-2013 PAD System™ International Limited. All rights reserved. 
71

6 Enter the desired values. Click the OK button to execute the function. Each pleat  
  has a symbol for folding direction. 

 

 

New Pleat Characteristics  
There are 2 items in Pleat Type for you to choose: 
Box Pleat  
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Inverted Pleat 

 
 

 

Support 0 Value on Pleat A 
It supports the value in 0 of the Width for Side A (Pleat A). 
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Create Multiple Darts & Define Dart Orientation 
The Dart tool allows you to create multiple Darts within a shape from its contour.  
 

To create multiple darts: 
1 Draw segments attached to the contour where the darts are located.  

 
2 Select the Dart tool 
3 Click the pivot point (#1) 
4 Click one of the segments (#2) indicating the position of the dart 
5 Click the part of the piece (#3) that remains fixed 
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6 The Dart Characteristics dialog box opens. Enter the dart parameters in the dialog    
  box. 

   
 
7 Click the OK button to execute the function 

   
 

 

 

 



 

© 1988-2013 PAD System™ International Limited. All rights reserved. 
75

Dart Orientation at the Center 
 
To do so: 
1 Draw a segment attached to the contour where the dart is located.   

   
2 Select the Dart tool 
 
3 Click the pivot point (#1) 
 
4 Click on the segment (#2) indicating the position of the dart 
 
5 Click the segment again (#3) that remains fixed 
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6 The Dart Characteristics dialog box opens. Enter the dart parameters in the dialog  
  box. 

  
 
7 Click the OK button to execute the function. 
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Enhance Dart Characteristics 
The Dart tool can assign dart characteristics into an internal line after digitizing or in 
pattern development. 
 
To do so: 
1 Activate the internal line where you want to add the dart characteristics. 
2 Select the Dart tool. 
3 Click on the tip of the internal line. 

 
 
4 The External Dart Characteristics dialog box opens. The length of the dart  
  corresponds to the length of the internal line. Put the values and characteristics  
  as needed. 
5 Click the OK button to execute the function. 
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Example of adding a dart width with 2 difference values into an Internal Line: 
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Example of adding a dart into an Internal Line: 
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The External Dart Characteristics dialog box offers the following options: 
Length: Length of the internal dart. 
Punch Hole Distance: It is the distance of the punch hole from the dart pivot point. 
Internal Width: Width of the internal dart. 
Finished Length: It calculates the position of the punch hole at the center (Internal  
Width of the Dart) to the Dart tip. 
External Width: Width of the external dart (locate at the contour line). 
Finished Length: It calculates the position of the punch hole from the dart head to 
the center of the Internal Dart. 
Pleat Length: It applies the dart width value at a distance calculated from the dart 
head to the center of the Internal Dart. This results in a dart pleat. 
Closing Side Clockwise: If checked, this option folds the dart clockwise. If 
unchecked, this option folds the dart counter-clockwise. 
Punch Hole Distance From Side: It customizes the distance of the punch hole from 
the sides of the dart. 
Cut Jug at: It assigns a specific length to the dart head. 
Save as Default: It keeps the settings of the dart (finished length, punch hole, etc.) 
and reapply these settings to all future darts. 
Remove Characteristics: This option is only available when you edit a dart already 
created. Check it to remove the characteristics you set to your piece. 
 
To Select a Dart: Select the dart by clicking its center segment. This selects the full 
dart. 
To Modify a Dart: Select the dart and select Item Info... in the Treatment menu to 
reopen the External Dart Characteristics dialog box. 
To Delete a Dart: Select the dart and press Backspace (Windows / Linux) or Delete 
(Macintosh). This removes the attributes of the dart and keeps the opening of the 
dart.
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Draw Parallel Line by Free Hand 
To do so: 
1 Activate the shape to create a parallel line 
2 Select Parallel Line tool 
3 Click on the shape and drag the direction to create a parallel line. 
 

 
 

4 Dash line appears and indicates the position of the parallel line. The distance   
  value displays on the Info bat at the right side bottom.  
  Mouse left click to confirm the location.  
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Display Measurement on Segment 
It can show the measurement on Whole Pattern Piece or the selected Segment. It 
allows showing value for the piece with Seam Allowance. But this feature does not 
support on Graded Pieces. 
 
Showing Measurement on Whole Pattern Piece 
By checking Segment Value from View menu and Show 

  
The whole piece shows the value calculated by each segment. It calculates along 
the segment between 2 Regular Points. Curve point and Mark point are included.   

 



 

© 1988-2013 PAD System™ International Limited. All rights reserved. 
83

Showing Measurement on the Selected Segment 
To do so: 
1 Select the desired segment(s) 
2 Select the Ruler tool 
  Or, Press “R” key for the Hot Key of Ruler tool 
3 Press “R” key again 
4 The value displays on the selected segment as follows. 
  Sample 1: The value calculates for one segment. 

         
  Sample 2: The value is two segments combined. 

    
5 The value keeps showing with the piece until remove it. 
6 Support to show the value on Seam Allowance 
 
Remove Measurement on the Selected Segment 
1 To remove the value, select the desired segment(s).  
2 Select the Ruler tool.  Or, Press “R” key for the Hot Key of Ruler tool 
3 Press “R” key again 
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Show Grid on Background 
Show Grid to the Background. You can select the Unit of the Grid size under 
Options menu, Preferences… and Display tag page. The dimension of the Grid’s 
Resolution is default to 1/1. 
 
By checking Grid from View menu and Show to show Grid in background 

   

 
Uncheck View menu Show Grid 
 
To check if the Snap to Grids is activated, it allows moving the pieces or elements 
on the working area using pre-defined grid steps. You can deactivate it at any 
time. 
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Pre-Set Hot Key for Tools 
Select Options -> Preferences- General -> Hot Keys->Tool. The most used tools 
create the default hot key as follows. 

 
Hot Key for the tools most frequent used: 
Ruler -- R 
Rectangle -- T 
Segment -- S 
Curve -- C 
Parallel -- Y 
Point -- Q 
Add Point to Segment --D 
Walking Piece -- W 
Segment Length -- E 
Add Seam -- A 
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Default More Symbols to Punch Hole List 

 

Default More Style Lines to Segments List 
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Combine “Save a Copy…” to “Save as…” 
The item Save a Copy… combines to Save as…, you can choose the version to 
save in Save as Type drop-down menu. It is default using the same file name with 
_Copy at the end and you can rename it as well. 
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Simplify a number of tools 
 
Combine the tools Join Shapes and Split Shapes into one tool Join/Split Shapes.  
Combine the function of “Circle” into “Ellipse”. 
 
Join/Split Shapes  

 

How to JOIN Shapes: 
1 Select two segments need to join together 
2 Select Join/Split Shapes 
3 Click the fixed point of the first segment or segment path (this shape remains in  
  position). 
4 Click the corresponding fixed point of the second segment or segment path  
  (this shape moves to fuse to the first one). 
5 Two pieces join together 
6 To save the style line as an internal line, use the Shift key (Windows, Macintosh and   
  Linux) while doing the steps 3 and 4. 
 
 
How to SPLIT a Shape: 
1 Select the style line and all the segments that are on one side of the shape need  
  to be split. (It does not matter which side you choose). 
2 Select Join/Split Shapes 
3 Click on the style line. 
4 The piece splits to two pieces. 
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Ellipse / Circle 

 
To draw a Circle by free hand: 
1 Select Ellipse / Circle 
2 Hold down Shift key and hold down the left mouse button 
3 Move the cursor to the desired radius and release the mouse button 
 
To draw a circle freehand by one click with Ctrl key (Windows/Linux) or 
Command key (Macintosh): 
1 Select Ellipse / Circle 
2 Hold down Shift key, click the starting point and hold down the left mouse button 
 (Windows/Linux) or the mouse button (Macintosh). The first click point is the center  
 of the circle. 
3 Move the cursor to the desired radius, hold down Ctrl key (Windows/Linux) or  
  Command key (Macintosh) and release the mouse button. The first point  
  changes to the corner of the rectangle bounding the circle. 
 

 

To draw an Ellipse by free hand: 
1 Select Ellipse / Circle 
2 Move the cursor to the desired radius and release the mouse button 
 
   
To draw an Ellipse freehand by one click with Ctrl key (Windows/Linux) or 
Command key (Macintosh): 
1 Select Ellipse / Circle 
2 Click the starting point and hold down the left mouse button (Windows/Linux) or  
  the mouse button (Macintosh). The first click point is the center of the ellipse. 
3 Move the cursor to the desired radius, hold down Ctrl key (Windows/Linux) or  
  Command key (Macintosh) and release the mouse button. The first point  
  changes to the corner of the rectangle bounding the circle. 
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To draw an Ellipse / Circle, using precise measurements: 
1 Select Ellipse / Circle 
2 Hold down the Alt key (Windows), the Option key (Macintosh) or Alt + Windows  
  Keys (Linux). 
3 The Draw Ellipse dialog box opens: 

    

4 Choose the radio button for Full Axis or Half Axis 
5 Enter the desired Height, Width, Angle or Circumference measurement. 
6 Click the OK button to execute the function.  
 
Options in the Draw Ellipse dialog box: 
 
Full Axis or Half Axis: The height and width measurements represent either half of 
the full height and width or the full height and width of the ellipse. 
 
Height: It determines the height of the Ellipse/Circle. 
 
Width: It determines the width of the Ellipse/Circle. 
 
Angle: It determines the orientation of the Ellipse. 
 
Circumference: It creates a circle with a circumference equal to the value entered 
in the text field. 
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Internal Segments: The Ellipse/Circle is drawn with internal segments attached to 
one another. They can be deleted so that the piece will not be a closed polygon 
anymore. Otherwise, the Ellipse/Circle is drawn with contour segments and remains 
a closed polygon if segments are deleted. 
 
Draw in Pieces View: The drawn Ellipse/Circle appears Pieces View. 
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Use Mouse Drag to Activate Segment 
 
Hold down left button on mouse and drag on the segment to activate. 

   

 
Note: It will activate the segment between Regular and Regular / Regular and 
Mark, Mark and Mark. Control points are included. 
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Memorize of Fabric List in Set Piece Dialog Box 
The item of Fabric in Set Piece’s dialog box, it can memorize the last selected fabric. 
Then the next piece will choose to the same fabric until you choose the new one. 
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Export to Illustrator 100% 
It can enter your desired value the file format for Illustrator. 
 

 
 

Scale: Enter the value to specify the export size of selected unit. 
The maximum is 100%; it is between 10% to100%. 
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Attach Image on a Pattern Piece 

Attach Image allows you to add it on the pattern pieces. A rectangle is surrounded 
the image, two regular points show on top right corner and left bottom corner that 
let you to manage the image. Image file treats as an internal shape; it supports all 
of operation as working on the internal section. 

 
File formats support as following: 
• BMP files (*.bmp) 
• GIF files (*.gif) 
• JPEG files (*.jpg, *.jpeg) 
• MNG files (*.mng) 
• PBM files (*.pbm) 
• PGM files (*.pgm) 
• PNG files (*.png) 
• PPM files (*.ppm) 
• TIFF files (*tif, *.tiif) 
• XBM files (*xbm) 
• XPM files (*xpm)  
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To attach an Image on the piece by using the Contextual menu: 

1 Right-click the piece (Windows / Linux) or click the piece while holding down the  
  Control key (Macintosh). 
2 Select the Attach Image… from the Contextual menu. 

    
3 Follow the directory, select the file and click open. Image will resize to fit in the  
   Pattern simulation area.   
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Reposition the Image File 
To activate the Image and freehand to move it by using Pointer tool to the new 
position. 
 

 
 
Or, to move the selected Image using the keyboard arrows: 
1 Select the Pointer tool. 
 
2 Select the Image(s) you wish to move. 
 
3 Use the directional arrows (Up, Down, Left, Right) to move the image(s) to  
  the desired location. 
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Rotate the Image File 
To rotate the Image freehand or to a precise angle X, Y or every 15° (Define the 
angle by the setting “Round Angle” in the Preference menu.) 
 
To rotate selected images by freehand: 
1 Select the image(s) you wish to rotate. 
 
2 Select the Rotation tool. 
 
3 Click the fixed point (pivot point). 
 
4 Click the second reference point and hold down the left mouse button  
 (Windows/Linux) or the mouse button (Macintosh). A reference dash guideline  
 going from the first point to the second point appears. Those two lines represent  
 an angle. 

 
 
5 Pivot the guideline to the desired rotation angle. 
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Hold down the Shift key (Windows and Macintosh) to constrain the rotation 
angle (X, Y or every 15°). 

 
When you hold and move the reference guideline, you can view the rotation angle 
at the fixed point (pivot point) or in the info bar. 

 
 
To rotate the image to a precise angle using numerical values: 
1 Activate the image(s) you wish to rotate. 
2 Select the Rotation tool. 
3 Hold down the Alt key (Windows), the Option key (Macintosh), the Alt + Windows  
  keys (Linux). 
4 Click the pivot point. The Rotate dialog box appears: 

   
 
5 Enter the desired value of rotation.   
 
6 Click the OK button to execute the function. 
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Resize the Image by freehand 

1 Select the Pointer tool. 
2 Select the Image(s) you wish to resize.  
3 Click one of the points at the corner and drag the mouse to resize the image. 

  

Able to Scale the Image 

To scale an image, activate the desired image and click the Scale... item in the 
Treatment menu. The Scale dialog box appears. To scale an image, select the 
appropriate radio button and enter the desired scale values.  
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Add Grading Value to the Image 

It allows adding grading value to the regular point located at 2 corners. 
1 Select the point(s) required on the image. 
2 Select the Grading Info... item in the Grade menu or press Ctrl+J.  
  The Grading Info dialog box appears. 

   
3 Enter the X and Y coordinate values of the point(s) in the dialog box. 
4 Press on the OK button to validate the operation. 
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Show the Image on the Pattern 

The Show menu and Image item in the View menu allows you to view or hide the 
Image(S) in the working area: 
Image: By checking Image, you can display all the Images to the pieces.  

 

 

Saving Image Files 

It saves the Image file automatic when you save the Style file. The extension of the 
Image file is .pmg. Please be sure to put the Style file(.sty) and the Image file (.pmg) 
into the same directory.  
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Missing Image Files 

If you change the name of the Style file (.sty) or the Image file (.pmg), it may result 
in file missing and dialogue box will pop-up as below: 

 
Continue – Choose the directory of the Image file 
Cancel – Close the dialogue box. If the image file is not found, it will show a 
rectangle instead. 
 

Plot Image on the Piece from Wide Printer 

The item in Plot and Piece Info allows you to plot the image on the piece. 
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Note: It will plot out a rectangle in DASH LINE if the plotter does not support Image 
plotting. 
 

Convert Style File with Image to Another File Format 

When exporting Style file to the file format as follows: 
DXF-AAMA  
DXF-ASTM 
Illustrator(.txt)  
Plot File(.plt) 
 
Images on the piece will become a rectangle (Regular Line) if converting to DXF, 
Illustrator(.txt) and Plot file(.plt). 
 


